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Chapter 1 - What is WTS Integration Manager?

Introduction

Constraints

The Web Timesheet Integration Manager for Peachtree allows
users to export time and/or expense data from Web TimeSheet
to Peachtree Complete Accounting.

Initially, a user must define templates within Peachtree
Complete Accounting. The templates will ensure that data is
imported from Web TimeSheet in the proper format. Setting up
the templates is a one-time process. Refer to Chapter 3 - Using
Web TimeSheet Peachtree Link for further information about
setting up templates.

Technical Requirements

The following applications are required to successfully export
data from Web TimeSheet to Peachtree Complete Accounting
using the Web TimeSheet Peachtree Link:

e Peachtree Complete Accounting 2003
e Web Timesheet 5.5 or higher (SQL or Access)

e Microsoft Internet Explorer 4.0 or higher/Netscape 4.x or
higher (excluding Netscape 6.x)

The date format for the user running the export must be
dd/mml/yyyy for International installations and mm/dd/yyyy
for installations within the United States and Canada. The
same date format must also be set up in the Windows
regional settings on the machine where Peachtree
Complete Accounting is installed.

The information for specific Web TimeSheet fields must
match existing fields in Peachtree Complete Accounting, as
noted below.

Web Timesheet Field Peachtree Field

Task Code Activity ltem Id
Client Code Customer Id
Employee Id Employee Id

Expense Code Charge Item Id



Note ...

Make sure you install
Web TimeSheet before
installing the Web
TimeSheet Integration

Manager for Peachtree.

Before You Install

Before installing the 5.5 version of the Web TimeSheet
Integration Manager for Peachtree, make sure you have already
installed Web TimeSheet 5.5. The Integration Manager for
Peachtree will need to be installed in the Web TimeSheet 5.5
directory.

Running the Installation

This section explains how to complete the installation of the
Web TimeSheet Integration Manager for Peachtree.

You will need to purchase Web TimeSheet Integration Manager
for Peachtree and obtain the WTS55PeachtreeLink.exe file from
Replicon Customer Support. You will also need to obtain a valid
license key for the Integration Manager.

The Installation Wizard will guide you through the installation
process.

1. Back up the Web TimeSheet database.

2. Launch the WTS55PeachtreeLink.exe file. The Welcome
screen is displayed.

Chapter 2 - Installing the WTS Integration Manager

‘wielcome to 'w'eb TimeS heet Integration Manager
@ for Peachtree Setup program. Thiz program will
= install'web TimeSheet Integration kanager for
Peachtree on your computer.

It iz strongly recommended that vou exit all Windows programs
befare running this Setup Program.

Click Cancel to quit Setup and close any programs vou have
unning. Click Next bo continue with the Setup program .

WARNIMNG: Thiz program iz protected by copyright law and
international treaties.

Unautharized repraduction or distribution of this pragrar, or any
portion of it, may result in zevere civil and criminal penalies,
and will be prosecuted to the maximum extent possible under
law.

Cancel I

3. Next you will need to specify the directory where the Web
TimeSheet Integration Manager for Peachtree should be
installed.

The Integration Manager for Peachtree must be installed
in the root of the Web TimeSheet directory. Use the
Browse button to locate the Web TimeSheet directory.

‘_G— Choose Destination Location x|

Setup will inztall 'web TimeSheet Integration kanager for
Peachtree in the following folder.

Ta install into a different folder, click Browse, and select
another folder.

“Y'ou can choose not to ingtall Web TimeSheet Integration
tanager for Peachtree by clicking Cancel to exit Setup.

" Destination Folder

C:\Program Filezsweb TimeShest Browse... |

Cancel |




Now you are ready to install the Web TimeSheet
Integration Manager for Peachtree. Click the Next button
to start the installation.

;:jt Start Installation il

“You are now ready to instal 'wWeb TimeSheet Integration
M anager for Peachtree.

Press the MNext button to begin the installation or the Back
butkon to reenter the installation information,

Cancel I

When the installation is complete, click the Finish button
to close the Installation Wizard.

;'.?7‘ Installation Complete il

‘wieh TimeSheet Integration Manager for Peachtree has been
successfully installed.

Press the Finizh button to exit this installation.

LCanze|

< Back

7. You are now ready to use the Web TimeSheet Integration
Manager for Peachtree.
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Note ...

You must have
appropriate Web
TimeSheet permissions
to access the Peachtree
Link reports.

Refer to the Web
TimeSheet User Manual
for further information
about permissions.

Accessing WTS Integration Manager

The Web TimeSheet Integration Manager for Peachtree is
accessible as multiple reports from within Web TimeSheet. You
can access these report as follows:

1. Log in to Web TimeSheet and click on the Reports button
at the top of the screen.

2. Select one of the following reports under the Peachtree
heading in the side menu:

e Peachtree Time
e Peachtree Expense
e Peachtree Expense Rate

Preparing for the Export

Before exporting Web TimeSheet data to Peachtree Complete
Accounting, you must set up the import format templates within
Peachtree Complete Accounting. These templates will ensure a
smooth data transfer from Web TimeSheet to Peachtree
Complete Accounting.

You will need to set up Time Ticket Register and Expense Ticket
Register import templates.

To set up the Time Ticket Register import template:

1. Open Peachtree Complete Accounting. In the File menu,
click on Select Import/Export.

2. Select Time/Expense from the list of available imports.

Select Time Ticket Register and click on the Import
button to modify the import format.

4. Modify the Time Ticket Register fields as outlined in Table
2-1: Time Ticket Register (Field Format).

5. When you're finished, click the Save button and enter a
unique name for the template. This name will differentiate
the modified template from the system template provided
by Peachtree Complete Accounting.

2-1: Time Ticket Register (Field Format)
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Show
Yes
Yes
Yes
Yes
Yes

Yes

Yes
Yes
Yes
Yes

Yes

Yes
Yes
Yes
Yes
No
No
No
No
No
No
No
No

Title
Yes
Yes
Yes
Yes
Yes

Yes

Yes
Yes
Yes
Yes

Yes

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

Yes

Field Column Break Column #

Ticket Number
Employee/Vendor
Duration

Billing Type
Manual/Timed Option

Has Been Used In
Payroll

Pay Level
Customer/Job/Adm
Completed For ID
Activity Item ID

Has Been Used in
Sales Invoicing

Billing Status
Billing Rate
Recorded By ID
Ticket Date
Invoice Number Used
Start Time

End Time
Break

Internal Memo
Unit Duration
Billing Amount

Ticket Description
for Invoice

Yes
Yes
Yes
Yes
Yes

Yes

Yes
Yes
Yes
Yes

Yes

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

Yes
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To set up the Expense Ticket Register import template, You must also set up the format for rate-based expenses, such Note ...

complete Steps 1-2 for setting up the Time Ticket Register as mileage. To set up the Expense Ticket Register import
template. Then follow the instructions below: template for rate-based expenses, follow the instructions below: Make sure you save the
. ) modified import

1. Select Expense Ticket Register and click on the Import 1. Open the template for flat expenses (the template may still template with a unique
button to modify the import format. be open, unless you closed it after saving the new name.

2. Modify the Expense Ticket Register fields as outlined in template). DODIOT evepaize s
Table 2-2: Expense Ticket Register - Flat Expenses (Field 2. Modify the import format as outlined in Table 2-3: Expense B INE SEET
Format). This format will be for flat amount expenses. Ticket Register - Rate-Based Expenses (Field Format). template, as you may

want to use this generic

3. When you're finished, click the Save button to save this 3. When you're finished, click the Save button to save this template to set up other
format and enter a unique name for the template. This format and enter a unique name for the template. This imports in the future.
name will differentiate the modified template from the name will differentiate the rate-based expense format from
system template provided by Peachtree Complete the flat expense format.

Accounting.
2-2: Expense Ticket Register - Flat Expenses (Field Format) 2-3: Expense Ticket Register - Rate-Based Expenses (Field Format)
Show Title  Field Column Break Column # Show Title  Field Column Break Column #

Yes  Yes Ticket Number Yes 1 Yes Yes Ticket Number Yes 1

Yes Yes Employee/Vendor Yes 2 Yes Yes Employee/Vendor Yes 2

Yes Yes Charge Item ID Yes 3 Yes Yes Charge Item ID Yes 3

Yes Yes Reimbursable to Yes 4 Yes Yes Reimbursable to Yes 4

Employee Employee

Yes Yes Ticket Description Yes 5 Yes Yes Ticket Description Yes 5

for Invoice for Invoice

Yes Yes Custmer/Job/Adm Yes 6 Yes Yes Custmer/Job/Adm Yes 6

Yes Yes Completed For ID Yes 7 Yes Yes Completed For ID Yes

Yes Yes Has Been Used in Yes 8 Yes Yes Has Been Used in Yes 8

Sales/Invoicing Sales/Invoicing
Yes Yes Billing Status Yes 9 Yes Yes Billing Status Yes 9
No Yes Unit Price Yes Yes Yes Unit Price Yes 10
No Yes Quantity Yes Yes Yes Quantity Yes 11

Yes Yes Billing Amount Yes 10 No Yes Billing Amount Yes

Yes Yes Recorded By ID Yes 11 Yes Yes Recorded By ID Yes 12

Yes Yes Ticket Date Yes 12 Yes Yes Ticket Date Yes 13

No Yes Invoice Number Used Yes No Yes Invoice Number Used Yes
No Yes Internal Memo Yes No Yes Internal Memo Yes



Note ...

Peachtree Complete
Accounting will prompt
you to back up your
Peachtree installation
before importing time or
expense data. lItis
recommended that you
perform this backup to
prevent possible data
corruption.

Only data for approved
timesheets/expense
sheets will be included
in the export.

Running the Export

Accessing the Exported Data

Now that you have set up the import format within Peachtree
Complete Accounting, you can export the data from Web
TimeSheet.

To export the data:

1. Click on the Reports button at the top of the Web
TimeSheet screen.

2. Select one of the following reports under the Peachtree
heading in the side menu:

e Peachtree Time
e Peachtree Expense Rate
e Peachtree Expense

3. Select the timesheet period or date range for which you
want to export time or expense information.

4. If you would like to review the data before exporting it to
Peachtree Complete Accounting, click on the Generate
button to generate the report for the time period you
specified.

5. Click on the Peachtree button to export the data to a .csv
file that can be opened in Peachtree Complete
Accounting.

When you export time/expense data, Web TimeSheet creates a
.csv file that can be opened in Peachtree Complete Accounting.

Peachtree Complete Accounting will import the data in the .csv
file ONLY IF the fields are properly set up. Refer to Chapter 1 -
What is Web TimeSheet Peachtree Link? for further information
about the field constraints between Web TimeSheet and
Peachtree Complete Accounting.

To open the .csv file in Peachtree:

1. Open Peachtree Complete Accounting. In the File menu,
click on Select Import/Export.

2. Select Time/Expense from the list of available imports.

To import time information, select the Time import you set
up previously and click on the Import button. For expense
imports, select the appropriate expense import format (flat
amount or rate-based).

4. On the Options tab, make sure you specify the location
where you saved the export file.

Select the First Row Contains Headings check box.

When you are ready, click the OK button to continue with
the import. It is recommended that you back up your
Peachtree company data to prevent data corruption.



Chapter 4 - Field Relationships -

Web TimeSheet to Peachtree Complete Accounting (Time Ticket Mapping)

Web Timesheet (source)

Peachtree (target)

Note ...

Constraints The data in the .csvfile

Timesheet Entry ID

Ticket Number

will imported into

The Timesheet Entry ID is an auto-generated key created within the Web
Peachtree Complete

TimeSheet database. Timesheet Entry ID cannot be modified from within Web

TimeSheet. Accounting ONLY IF the
fields are properly set
N/A Employee/Vendor Web TimeSheet does not differentiate between employees and vendors. up. Refer to Chapter 1 -
Therefore, Web TimeSheet always uses a value of “0” to indicate that the What is WTS Integration
exported time has been entered by an employee. Manager? for further
Duration Duration none Iyjie ol et s
field constraints
N/A Billing Type Constant value of ‘2’ to indicate the rate is included in the export. between Web
N/A Manual/Timed Option Constant value of ‘1’ to indicate that the duration calculation is manual Emeﬁtheetgnd =
completed within Web TimeSheet. eachtree Lomplete
Accounting.
N/A Has Been Used in Payroll Constant value of ‘FALSE’ to indicate that payroll information is not generated
from within Web TimeSheet.
N/A Customer/Job/Adm Constant of ‘1’ indicating expense entry for customer
Client Code Completed For ID This field must match an existing Customer Id within Peachtree Complete
Accounting
Task Code Activity Item ID The task code associated with a specific project/task in Web TimeSheet. This
field must match an existing Activity Item ID in Peachtree Complete Accounting.
N/A Has Been Used in Constant value of ‘FALSE’ since time entry cannot be invoiced directly from Web
Sales/Invoicing Timesheet
Billable Billing Status ‘1’ for billable and ‘2’ for non-billable time
Employee Id Recorded By ID none
Entry Date Ticket Date Incursion date of time. Must be exported in format dd/mm/yyyy for
International Customers and mm/dd/yyyy for American and Canadian customers.
unused Invoice Number Used N/A
unused Start Time N/A
unused End Time N/A
unused Break N/A
unused Internal Memo N/A
unused Unit Duration N/A
unused Billing Amount N/A
unused Ticket Description N/A

for Invoice




Note ...

The data in the .csvfile
will imported into
Peachtree Complete
Accounting ONLY IF the
fields are properly set
up. Referto Chapter 1 -
What is WTS Integration
Manager? for further
information about the
field constraints
between Web
TimeSheet and
Peachtree Complete
Accounting.

Web TimeSheet to Peachtree Complete Accounting (Expense Ticket Mapping)

Web Timesheet (source)

Peachtree (target)

Constraints

Expense Entry ID

Ticket Number

The Expense Entry ID is an auto-generated key created within the Web
TimeSheet database. Expense Entry ID cannot be modified from within Web
TimeSheet.

N/A

Employee/Vendor

Web TimeSheet does not differentiate between employees and vendors.
Therefore, Web TimeSheet always uses a value of “0” to indicate that the
exported expenses have been entered by an employee.

Expense Type Code

Charge Item ID

Expense type code associated with a specific expense type.

Reimburse

Reimbursable to Employee

TRUE or FALSE depending on the value within Web Timesheet

Expense Entry Description

Ticket Description for
Invoice

none

N/A Customer/Job/Adm Constant of ‘1’ indicating expense entry for customer

Client Code Completed For ID This field must match an existing Customer Id within Peachtree Complete
Accounting

N/A Has Been Used in Constant value of ‘FALSE’ since time entry cannot be invoiced directly from Web

Sales/Invoicing Timesheet

Billable Billing Status ‘1’ for billable and ‘2’ for non-billable expenses

Rate Unit Price none

Quantity Quantity none

Expense Amount Billing Amount none

Employee Id Recorded By ID none

Entry Date Ticket Date Incursion date of expense. Must be exported in format dd/mm/yyyy for
International Customers and mm/dd/yyyy for American and Canadian customers.

unused Invoice Number Used n/a

unused Internal Memo n/a
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